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Stream 3.1 Software 
 

Stream 3.1 Requirements and Licensing 
 

System Requirements 

Stream 3.1 requires Windows XP SP3 (or higher) or Windows Server 2003 32-bit operating systems. 

Windows Vista Business and Ultimate Editions are also supported, however, please see the Known 
Limitations section at the end of this document for Vista settings requirements and known limitations. 

Windows Server 2008 32-bit operating system is currently being tested with Digital Rapids Stream. For 
use with AVI and Windows Media/VC-1 you must install the ―Desktop Experience‖ option. 

64-bit operating systems are not currently supported. Windows 2000 is no longer supported. 

Stream 3.1 requires a P4 CPU or better.  Faster processors and/or multi-core processors are 
recommended for processor intensive codecs. 
 

Registration 

 
YOU MUST REGISTER YOUR PRODUCT TO UNLOCK ALL FEATURES.   
 
Go to http://www.digital-rapids.com/Support/Registration.aspx to register your product. 
If you have already installed the Stream software you may use Tools > Register Online to go to the 
registration page with your product ID automatically filled in for you. 
 

License 

If you have a Stream 3.0 license key you will not require a new license key for Stream 3.1. 

Stream 2.5 to 3.1 is a paid upgrade which requires a new license key. If you purchased Stream 2.5 in 
2009 you are eligible for a free upgrade. Please contact Digital Rapids Support for your new, updated key. 

Purchase of Stream 3 includes one year of software maintenance. Software maintenance includes free 
―point upgrades‖ (e.g., upgrade from 3.0 to 3.1) and basic support (basic support includes phone support 
during regular business hours and email support). 

Stream 2.x will no longer be supported as of January 1, 2010.  
 

Installation/Upgrade Notes 
 
WARNING for DRC Studio AVC customers upgrading from Stream 3.0: 

When encoding using MBAFF mode ONLY you will see a significant performance decrease compared to 
Stream 3.0. You will still be able to encode an SD input in real time using MBAFF. However, if you are 
encoding multiple profiles simultaneously, real time performance will be affected. Transcoding speeds will 
be approximately 50% of the speeds in Stream version 3.0. This does not affect 720p or 1080p or 1080i 
encoding, just MBAFF. This will be addressed in a Stream 3 maintenance release. 
 

Note For those upgrading from Stream 1.5 or 2.x  

Codec Profiles and Projects saved in Stream 2 or 3 cannot be used in Stream 1.5.   
 
For best results in Stream 3, you should rebuild your codec profiles and projects in Stream 3. New sample 
codec profiles and projects will be installed with Stream 3. 

http://www.digital-rapids.com/Support/Registration.aspx
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INSTALLATION NOTE for Windows Media 
When you install Stream, the installer will detect which version (if any) of the Windows Media codec you 
have installed.  If it is older than the codec installed with Windows Media Player 11, then you will see a 
window that recommends that you upgrade, and the installer will copy the required wmfdist_v11.exe file 
to your system.  (On Windows XP systems this file will typically be copied to C:\Program Files\Common 
Files\Digital Rapids\WMF Installer\wmfdist_v11.exe.) After Stream has been installed, run this file to 
install the latest Windows Media codec. 
 
INSTALLATION NOTE for QuickTime:  If you intend to encode to or transcode from QuickTime files, 
then Stream 3.0 or higher requires the QuickTime 7 player to be installed. If you install QuickTime 7.4 (or 
newer) the default codec list will be shorter then with previous versions of the player. To show the 
complete list, open the QuickTime player, select Edit > Preferences > QuickTime Preferences, then select 
the Advanced tab, and check the "Enable encoding using legacy codecs" box. 

Note that the QuickTime H.264, AAC audio and AMR audio codecs are enabled in Stream 3 for Stream 
FE, but not for Stream LE. 
 

Installation Options 

The Stream Installer includes optional components that you will see if you select a ―Custom‖ install and 
expand the install tree. 

 
 

Tips for using StreamZHD software (DRC-5550/5650)  
 
For HD capture be sure to direct your Output Media to the video RAID (4 or more drives striped together).  
If you attempt to capture uncompressed HD video to your system drive it will not be able to keep up and 
you will see dropped frames after the buffer fills to 100%. 
 
For HD capture you can capture any resolution or frame rate to an uncompressed AVI or DRC Video file 
in real time.  For capture to other codecs the real time capabilities will be dependant on the host system.   
 
Input Source Profiles (for live capture or deck capture) are different for the HD boards than for SD boards. 
For example, for HD boards deinterlacing is set in the Source Profile, it is not a setting on the Video 
Process tab as it is for the SD boards. Please refer to the Stream Software User’s Guide. 
 
For standard definition NTSC video, the HD board can be set to capture to 720 x 486 or 720 x 480.   
If you need to capture 720 x 480 (for example for a DVD), be sure to select this in the source profile so 
that later the video is not scaled from 486 to 480. (Note that 720 x 512 is also an NTSC option, for cases 
where you need to capture all of the VBI lines.) 
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Stream 3.1.0 Highlights 
 
Windows Media Smooth Streaming support 
- VOD file creation support (2-pass) using the Microsoft SSE SDK and the Digital Rapids smooth 
streaming container 
- Live smooth streaming support and on-demand file creation (1-pass) using the Microsoft enterprise VC-
1 SDK and the Digital Rapids smooth streaming container 
- DFXP closed captioning support (708 cc file format) 
- Note: Smooth Streaming is enabled in both  Stream FE and LE. In Steam 3.1 the group codec will be 
enabled and the following will be supported in the group codec by default: VC-1, SSE, WMA, WAV, 
Smooth Streaming container, ASF muxer, Elementary Stream File 
If you are upgrading from Stream LE 3.0 to Stream LE 3.1 you will need a new key to enable this feature. 
 
Support for manual selection of AFD (Active Format Description) in MPEG2. 
Note: AFD is not currently preserved when transcoding from MPEG2 or capturing from SDI 
 
Support for ad insertion points (SCTE35) from a text file when using the Manzanita Transport Stream 
muxer (in the group codec). 
 
Red Camera file decoding available as a new, chargeable input option. 
 
XDCAM HD 4:2:2 50 Mbps MPEG2 support with support for MXF wrapping in the group codec. 
 

Stream 3.0.0 Highlights 
 

New Plugins included in Stream FE 
Audio Plugins: Level (Volume), Down Mix 5.1 to Stereo, Stereo to Mono, Channel Remapper/Selector  
Video Plugins: Proc Amp, Black & White, Rotate 90 degrees, Burn in Timecode/Time of day 
Third party DirectShow and DMO plugin support for both audio and video plugins. 
New Optional Plugins: 
Civolution Teletrax watermark plugin: embeds watermark and creates Teletrax log file; requires a dongle 
Thomson NexGaurd watermark plugin: embeds watermark and creates NexGaurd log file; requires 
license files from Thomson (generated from a Thomson system ID). 
Note that CompoTrack plugin has also been updated to new SDK. 
 

Closed captioning 
Full CEA-608/708 DTVCC closed captioning support 
If the source includes only 608 cc, then Stream will both embed that 608 and translate the 608 to 708 and 
embed that in the 708 dataspace. (Previously in Stream 2.x and earlier Stream was not doing this 608 to 
708 translation, and the 708 dataspace was being left empty.) 
If an SDI source includes cc in the ancillary data then Stream is embedding the 608 and/or 708 found in 
that ancillary data. (Note that in order to meet spec the HD SDI ancillary data is required to carry cc data 
in both the 608 and 708 dataspace.) 
Full CEA-608/708 DTVCC closed captioning been implemented for the following codecs: 
MPEG2, VC1, AVC/H.264 (DRC Studio AVC and Ateme); also supported in drcVideo format 
Additional codecs: 
DVCPro/DV supports 608 closed captioning (there is no spec for 708 cc in DVCPro). 
Preserving Closed Captioning when transcoding: 
Closed captioning will be preserved when transcoding from MPEG2 with CC to other file formats, 
specifically to MPEG2 and H.264 currently. 
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Caption retiming for Inverse Telecine (NTSC to Film): 
When using the inverse telecine plugin the captions will be retimed from 29.97 fps to 23.976 fps. 
Additional CC Tool: 
Added a tool to insert cc into a H.264 file using an scc file as a caption source; this tool is included if the 
customer has DRC Studio AVC or Ateme codecs. 
 

New Codecs and Wrappers 
 
DV, DVCPro 25, 50, 100/HD – in MXF, MOV, GXF, LXF or AVI; includes 608 cc preservation option 
 
AES3 audio encoder codec is present when the MXF wrapper is enabled – supports SMPTE Formats 
331M (for MXF D10), AES3-203 (MXF AES 3); AES3 audio decoding support is included for LE and FE. 
 
New GXF reader – fixes bugs in previous GXF reader 
GXF Wrapper (available as a Processor Profile in the group codec); can wrap MPEG1, MPEG2 or 
DVCPro video, plus PCM/WAV audio 
 
LXF reading – new input type 
LXF wrapper (available as a Processor Profile in the group codec); can wrap MPEG1, MPEG2 or DVCPro 
video, plus PCM/WAV audio. 
 
Dolby Digital AC3 encoder – Implementation of the Dolby Digital Professional Encoder SDK 
Options: Stereo File only, Stereo File + Live, Surround File only, Surround File + Live 
 
Dolby Digital Plus encoder – Implementation of the Dolby Digital Plus Professional Encoder SDK; This 
format can be used to provide audio for BluRay authoring. 
 
New MOV Muxer for wrapping MPEG-2 D10 and DV/DVCPro.  Also can be used to wrap AVC/H.264 plus 
audio. The output files can be imported into Final Cut Pro without additional rendering. 
 
Reading Avid DNxHD which is wrapped in MXF 
Writing Avid DNxHD – 8-bit and 10-bit support, all compressions supported; real-time encoding to VC-3 
files (elementary stream video) 
Wrapping DNxHD in MXF is supported. Import of these MXF wrapped files has been tested on Avid 
Media Composer.; Real-time wrapping of VC-3 in MXF is not possible on all systems. An automatic post-
encode MXF wrapping step is recommended when capturing from live sources or VTRs.  
(Note: Wrapping Avid DNxHD in MOV is planned for a future 3.x release) 
 
Added SRT subtitle file codec profile (can be used for timed text) 
 
Update to newer DR AVC/H.264 codec. This update is for both DR AVC for Flash and DR Studio AVC. 
- more efficient, multithreaded (allows 1 slice real-time HD encoding on fast systems) 
- Run 1080p in real-time on existing HD turnkey systems 
- For 1080i (true interlace or MBAFF) in real time the current turnkey is not quite fast enough for 
acceptable quality; we recommend a faster system. 
 
Support for RF64 WAV (WAV codec automatically uses RF64 if the WAV file grows over 4GB in size) 
 
Broadcast WAV support as an option in the WAV codec profile. (Use the BWF Clip Information button.) 
Note: only stereo Broadcast WAV files can be included in MOV, LXF or GXF files.  
Note: when wrapped in MXF the metadata in the Broadcast WAV file is lost. 
 
MXF wrapper: Added timecode track support; Only specific OP and encoders are supported. 
Include starting timecode from the following encoders: MainConcept MPEG2, DR AVC, Ateme, DVCPro, 
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Avid DNxHD; Also user-defined starting timecode is an option 
Operational Paterns: Op1a, IMX, eVTR, XDCAM DV, Avid OpAtom 
 
Added support for ASF/VC-1 captioning with a new script stream option for archive file creation only. (This 
is the type of captions that can be played in Windows Media Player.) Support for captioning script 
streams for live (broadcast) output will be addressed in a future build of the Stream software. 
 

Stream 3.1 Change History 
 

Stream 3.0.1.b50 to 3.1.0.b28 
 
Windows Media Smooth Streaming support. Added a new codec and a new group processor. 
 
Support for ad insertion points (SCTE35) from a text file when using the Manzanita Transport Stream 
muxer (in the group codec). 
 
Updated the codec used by DRC Studio AVC and DRC AVC for Web.  
 
Digital Rapids Studio AVC: 
- Closed captions can now be embedded for all encoding modes (interlaced, progressive, MBAFF). 
- Fixed a bug with 1080 psf 708 CC embedding in AVC. 
 
MPEG4 Muxer:  
- Added the capability to create multiple Timed Text (subtitle) tracks in an MP4 file. 
- Fixed a bug that was causing an invalid wrapping of interlaced AVC files. 
- Added support of Dolby Digital Plus (EC-3, or Enhanced AC-3) to the MPEG-4 muxer.  
 
Add a new DirectShow AVI Uncompressed UYVY 10-bit (v210) option that is compatible with existing 
DirectShow decoders. (e.g., Black Magic CODECs.v6.8.3.1.) 
 
Flash RTMP Streaming: Added more metadata to the live RTMP Flash output. Specifically: Frame height 
and width, codec type, audio/video bitrate, framerate 
 
Avid DNxHD codec profile: made some changes to the dialog for clarity (hopefully). 
Added an Interlace Mode selection to the Avid DNxHD codec profile. 
Fixed a crash when trying to transcode some MPEG2 files to Avid DNxHD 
 
Added a new Elementary Stream File processor for the group codec. 
 
System Tags: Fixed a bug where the tags: 
%PROF.PROC.#.ARCHIVE.FILENAME% 
%PROF.PROC.#.ARCHIVE.FILENAME.EXT% 
%PROF.PROC.#.ARCHIVE.FILENAME.FILE% 
%PROF.PROC.#.ARCHIVE.FILENAME.DIR% 
were not being processed correctly by the Group Codec. 
 
Modified System Tags lookup for Group codec profiles. The following will resolve to: 
%PROF.ARCHIVE.FILENAME.DIR%  -> %PROF.#.PROC.0.ARCHIVE.FILENAME.DIR% 
%PROF.ARCHIVE.FILENAME.FILE% -> %PROF.#.PROC.0.ARCHIVE.FILENAME.FILE% 
%PROF.ARCHIVE.FILENAME.EXT%  -> %PROF.#.PROC.0.ARCHIVE.FILENAME.EXT% 
%PROF.ARCHIVE.FILENAME%    -> %PROF.#.PROC.0.ARCHIVE.FILENAME% 
%PROF.ARCHIVE.DISKSPACE%     -> %PROF.#.PROC.0.ARCHIVE.DISKSPACE% 
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Fixed a bug for system tags used in the group codec when the group codec included multiple processors. 
The system tags had incorrect information because the order of the processor outputs in the project file 
did not match the order of the actual processors. 
 
Command Output (for a codec): Added a "Finish command output before starting other output functions" 
check box. Stream will appear ―busy‖ until the Command output is complete. 
Command Output (project level): Fixed an issue with project-level ―Command‖ output hanging if it prints 
too much output (around 1000 bytes) to the console (the Command Prompt window). 
 
The Archive output dialog for both MPEG-4 muxer and Nero Digital now has a Progressive Download 
checkbox. When this is enabled the encoder will be seen as ―busy‖ until the progressive download step 
has been completed. That is, no other output options will start until this step completes. 
For the MPEG-4 muxer there is still a Progressive Download option in the muxer, so that older projects 
will still work. However, for Media Manager compatibility, the new progressive download option on the 
Archive dialog should be used, and NOT the one in the muxer. 
 
Fixed a problem with the RTP/RTSP announce message where the line ending was incorrect, causing 
problems with some media servers (but not with the Darwin Media Server).  
 
QuickTime: 
- When transcoding from a QuickTime file, after Stream finished the transcode it was maintaining a lock 
on the QuickTime source file. It now correctly releases the file after the transcode completes.  
- Added support to handle decoding of various QuickTime audio bit types (8, 16, 24, 32-bits). 
- For QuickTime file decoding Stream now computes the video frame rate based on the media time scale instead 

of the movie time scale. Using the movie time scale was causing a rounding error. This fixes a problem where 
transcoding from QuickTime to uncompressed AVI files was resulting in an AVI file with a lip sync problem. 

- Fixed a bug that appears when updating the QuickTime Player from 7.2 to 7.6.2 that caused a crash 
when transcoding from some QuickTime files. 
 
MXF Processor: 
- Added support in the MXF processor for XDCAM HD Op Pattern. 
- Stopping encode of multiple MXF wrappers now always works (previously it would occasionally hang) 
- MXF Processor: Universal Label  in MXF metadata for MPEG Long GOP was incorrect 
- Solved a lip sync issue when trimming an MXF file that included MPEG2 
- MXF Wrapper: 3 Preserve timecode Modes: 
―Custom‖ allows you to set a user defined timecode and DF/NDF mode 
―Preserve from Video‖ uses the timecode setting found in the video codec profile 
―Preserve from Source‖ uses the timecode from a live input as defined on the Stream Input tab 
Implemented for the following codecs wrapped in MXF: MPEG, DNxHD and DVCPro 
 
Improved the error handling when transcoding from a file with invalid timecode. This fix catches the 
exception caused by the invalid timecode, and starts to increment the TC manually from then on. 
 
MainConcept MPEG:  
- Added XDCAM HD 4:2:2 50Mbps preset types to the Group Codec and to the Codec Profile menu. Note, 
this does not include MXF wrapping, just the MPEG2 video encoding. Warning: When using the XDCAM 
HD 4:2:2 codec profile it is possible to change all MPEG2 settings, even the ones that should not be 
changed in order to remain in spec for XDCAM HD 4:2:2. 
- XDCAM HD 4:2:2 profiles created in the Group Codec default to ―video only‖ with multiplex = none. 
- Updated the MPEG2 decoder and now Stream can decode MPEG2 files with multiple audio streams  
- Support for manual selection of AFD (Active Format Description) in MPEG2. 
 
Omneon Enhancements and Bug Fixes: 
- Omneon Wrapper Tool: add .dif video file type in the video list format 
- Omneon Wrapper Tool: remove ―use timecode from Deck‖ check box (doesn’t apply to the tool) 
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- Fixed an issue that caused an Omneon MOV reference file to report a '0-bit' audio file.  This was a result 
of the MOV file referencing a compressed audio format. If we detect this case we now try to extract '16-bit' 
audio. (Note: this will not work for some compressed audio formats, but not for all.) 
- Fix for Omneon MXF file containing MPEG2 incorrectly using the field height instead of the frame height 
when being decoded in Stream 
 
Red Camera file decoding: This is a new, chargeable option. 
The Red Camera file source frame resolution needs to be set before the decode  starts. 
By default Stream uses ―full resolution, highest resolution & quality‖ but this is also the slowest setting. 
To change the frame resolution used by the decoder you can use a registry setting. Available options: 
1 = DECODE_FULL_RES_PREMIUM full resolution, highest resolution & quality, but slow (Default) 
2 = DECODE_HALF_RES_GOOD half resolution, very good quality, fast 
3 = DECODE_HALF_RES_PREMIUM half resolution, highest quality, slow  
4 = DECODE_QUARTER_RES_GOOD quarter resolution, very good quality, fast 
8 = DECODE_EIGHT_RES_GOOD eighth resolution, good quality, fast 
16 = DECODE_SIXTEENTH_RES_GOOD sixteenth resolution, good quality, fast 
Please contact Digital Rapids Support if you are not comfortable changing your system registry. 
The registry setting: 
 Windows Registry Editor Version 5.00 
 [HKEY_LOCAL_MACHINE\Software\DRC\Stream\Codecs\] 
 "RedCamFileSourceRes"=dword:00000001 
 
ASF muxer: Fails when both Time of Day Script and CC Script are enabled. Now the ASF Dialog prevents 
user from selecting both script stream types in the same profile. 
 
Plugins: 
- DirectShow plugins : Added a new method to detect DirectShow plugins. When you use the ―Add 
DirectX Filters‖ option and select the DirectShow tab, you will now see a drop down box that allows you to 
choose between Standard and Legacy methods. 
- Deinterlace plugin: When Auto mode is selected the plugin will only deinterlace if it can detect that the 
source is interlaced. When transcoding from a file, the plugin looks for interlace/progressive information in 
the header of the file, and if it does not detect any, then it assumes the file is progressive. This 
information can be detected in some file types (e.g., MPEG2 and WMV) but not for others (e.g., AVI files). 
Previous behavior: auto mode does exactly the same thing as if Field Interpolate (Bob) was selected. 
New behavior for auto mode: if source is interlaced Field Interpolate (Bob), otherwise do nothing. 
- Timecode Overlay plugin:  added ―Render Timecode‖ mode with a starting time in frames. Added a Date 
and Time mode (which uses the system date and time). 
 
Added error message "Failed to load Hardware Graphic Overlay" when unable to load graphic overlay 
during monitoring and encoding. (Previous error message of ―Unable to Monitor.‖ was a bit vague.) 

 
Closed Captioning: To disable any 608 to 708 translation from being embedded into the encoded data 
use the following regkey entry: 
 Windows Registry Editor Version 5.00 
 [HKEY_CURRENT_USER\Software\DRC\608To708Trans] 
 "Disable"=dword:00000001 
This may be particularly helpful for STBs that can handle 608 but cannot handle 708 captions. 
 
The Tools > H.264 > Closed Caption Embedder should make a file once again. (Worked in Stream 2.5, 
but broken in Stream 3.0) 
 
Fix Bug – Transcode Manager tasks that used MXF source files were failing when the agent system was 
updated to  Stream 3.0.1. 
 
Maintenance expiry date now shown in Help > About info for Stream 
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Dolby Digital and Dolby Digital Plus: Changed default byte order to big endian by enabling the ―create 
stand alone file‖ checkbox by default. 
 
SDK: Fix a bug that affected deck capture projects running from the high-level API. 
 
The Hasp ―FKU‖ components needed to update a green Digital Rapids dongle have been added to the 
installer. 
 
The new DRC-5600 board model will now be identified correctly Stream. In Stream 3.0 a DRC-5600 was 
identified as a DRC-5650, but otherwise should work. 
 
Update to JRE1.6.0_14 for Stream 3.1.0 
 

Stream 3.0.0.b34 to 3.0.1.b50 
 
See the list of Stream 3.0 Highlights for an overview of Stream 3.0 changes. 
 
Windows Media Streaming: fixed a bug that prevented live streaming for more than approximately 6 – 7 
hours. 
 
Changed the merit of the Digital Rapids GXF filter so that it no longer interferes when decoding Transport 
Stream files. 
 
Added an optional checkbox to Dolby Digital to allow the codec to create a stand-alone AC-3 file with 
metadata that is accessible by third party muxers. (When this box is enabled the files are big endian and 
when it is disabled the files are little endian.) 
 
Refined some of the default settings for Dolby Digital and Dolby Digital Plus audio codecs. 
 
Made changes to ATSC and SCTE20 608 captions, in particular to the dual captions required for 
CableLabs compliance. 
 
Made changes to how closed captions are handled when coming from a 1080 psf source for 608 and 708 
closed captions. 
 
Made some changes to the defaults used when Stream translates 608 captions to 708 captions (for cases 
where 708 captions do not exist in the source), specifically to the default text formatting (default pen color, 
font size and display position). 
 

Stream 2.5.2.b63 to 3.0.0.b34  
 
The Grace Period has been removed. You now must register the software to run Stream. 
 
Synchronize A/V preview during encoding with a single codec (but not with the Group codec – that is, the 
encoded output will still be in sync, but preview of a group codec may be out of sync) 
 
2-Pass encoding is supported while using the Group Codec and Clip Lists 
 
VOD Package button as a post-encode output for MPEG2 (combines preexisting ADI files with media in a 
tar or folder – it is not used to create the metadata, that’s a separate app) 
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DVD Output enhancements:  
Publish from a clip list (When concatenate is selected a Chapter point will be put in at the beginning of 
each clip.  When concatenate is not selected a DVD will be created for each clip input as if they were 
single encodes.) 
Publish from a single live encode 
Menu-less DVD with chapters (Create DVD menu checkbox present on gui) 
Autoplay option (Will allow user to set the DVD to autoplay the first track of the video) 
Change font and color of text for title and chapters 
Support multi-line titles and chapter labels for DVD menus 
Add support for all system tags, including date (%D%) and time (%T%) tags 
Background color chooser (solid or gradient) 
 
Thumbnail selection (set a time for the image sequence to capture a frame) 
 
Files that are created by the user are now stored in a ―Vista friendly‖ place compared to earlier versions of 
Stream. There is a new ―Steam Documents‖ shortcut on the desktop that takes you to the new location. 
Also, when you upgrade from Stream 2.5 to 3.0 you have the option to use a ―file migration wizard‖ to 
move your existing files to the new location. All installed preset profiles/projects will be installed to the 
new location. 
 
Additional Codec/Technology Updates:  
Updated to newest On2 SDK 2.5.3.0. Added a check box to enable VP6-S mode. 
Updated to newest Dicas codec. Supports 2-pass H.264 encoding.  
Updated to newest Omneon MOV output SDK. 
Updated to MainConcept 7.6.1 SDK. 
Updated OpenCube SDK (used by Stream for MXF Wrapping) to v.2.1.4. 
Updated to Manzanita TS Muxer 5.2.0.v1. 
 
Added Stream Scripter as an option in the installer (during a custom install) 
 
Removed Compotrack Watermark Ticketing option. Any future plugin logging will be integrated with the 
plugin (as with the Teletrax or NexGaurd plugin). 
 
Removed Stream Remote options that were part of Stream Enterprise 2.5. 
 
Added the Maintenance date to the Help > About information. This date is when your maintenance 
expires. Maintenance entitles you to free ―point upgrades‖ (from 3.0 to 3.1 for example) and basic support. 
A warning window will pop up when you have 30 days remaining in your Maintenance period. 
 
Closed captioning: Fixed 608 SCTE20 packet construction. This was affecting the 608 dual format A/53 + 
SCTE20 captioning. 
 
If more than one MXF Processor is present in a Stream project, either in the same group or in a different 
group, then the process may hang. Currently a warning window opens when there is more than one MXF  
processor added to a Stream project.  
 
The MXF Processor now sets the Index Table to ―true‖ by default. The index table is required for seeking 
in an MXF file (and trimming based on that seek). 
 
Negative offset is now allowed for deck capture timecode reference. 
 
SDP file created for RTP streaming:  Added aspect ratio information ("a=cliprect:0,0,height,width") and 
more info to the 0 field in the SDP file. (o=<username> <sess-id> <sess-version> <nettype> <addrtype> 
<unicast-address>, but since there is no username field in our interface that is currently set to ―-―). 
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Change the warning that comes up when you enable VBI and then click OK. It had been warning you that 
―deinterlacing must be disabled‖, however changes have been made so that you no longer need to 
disable deinterlacing. 
 
Added new fields to the Omneon Wrapper Dialog: Start TC and use Deck TC. 
Ensure the Drop/Non Drop frame flag in the Omneon start TC field is correctly embedded in the MOV file. 
Better support for Omneon MOV file decoding - Switch to using DSFileSource when opening reference 
MOV files. 
 
Basic_WMDRM_Response.xml sample file: added a second = at the end of SignaturePrivKey 
This was needed so that when encrypted files were played in WMP, the user would be redirected to the 
URL specified (even if the key values used are bogus as they are in this example file). 
 
On the Input Tab, when Media Files is the input type, when "Audio Only" or "Video Only" is selected 
disable either the Video section or the Audio section (as appropriate). 
 
MXF file trimming: 
Fixed an issue when trimming large MXF files. 
Fixed an issue when trimming MXF files that contain MPEG2 I-frame only video (such as D10/IMX). 
Note: There is still a sync issue when trimming MXF files that contain MPEG2 with a GOP structure with 
IBP frames. 
 
MainConcept MPEG2: 
Changed the default field order for NTSC IMX streams to "Upper Field First". (to meet the IMX spec) 
The MPEG2 codec profile now allows you to customize the output file extension. 
Fixed a lip-sync issue when trimming MPEG2 files. (This does not fix the issue when it is MXF that 
contains MPEG2.) 
 
MPEG2 in a Transport Stream (using the Manzanita muxer): Changed the sending data out by using 
circular buffer so that the muxer won't wait any more. This may help with broadcast to some STBs. 
 
Trim duration in Stream was not being calculated correctly for 29.97 and 59.94 time code types. 
 
Fix for lost plugins when editing a DRC AVC for Flash codec profile. 
 
Added an option for delay on capture first frame for image sequence. (Can avoid capturing slates as the 
thumbnail for example) 
 
MPEG-4 Muxer: Added tag processing to metadata, text, and CC filenames. 
 
Trigger area on main GUI re-worked to give clearer indication of trigger status 
 
Added ability to handle AVI source files with DV content.  Fixes an audio up-conversion problem with 
12bit audio. 
 
Nero Digital codec:  
Made changes to cope when transcoding from source files when the source file has bad timestamps. 
Fixed a bug that prevented the saving of Chapter points from the Nero Muxer Settings.  
 
On2 VP6 codec: Made changes to cope when transcoding from source files when the source file has bad 
timestamps. 
 
Optimized the 601/709 Color Space Conversion plugin and the Color Space Converter plugin. 
 
Compotrack Watermarking plugin: Removed restriction on height with multiple of 8. (There is still a width 
restriction.) 



 Digital Rapids Stream 3.1 Software 

Digital Rapids Stream 3.1 Software September 9, 2009 11 of 21 Page 11 of 21 

 
For DRC-5550 or 5650 boards only:  
Allow trigger start/stop on timecode of types LTC, SDI-LTC, SDI-VITC1, SDI-VITC2 and SDI-ANY. 
 
QuickTime: 
QT File Source: Changed movie time scale to report more accurate frame rate. Should fix lip sync 
problems encountered when transcoding from QT to AVI. 
Fixed problem in QuickTime file source at the end of the video/audio stream, a NULL sample might not be 
sent. 
Added picture aspect ratio detection in QuickTime file source. 
 
MXF File Source: Fixed an occasional bug in AudioCallback that was causing the possible loss of the last 
audio packets. This issue occurred infrequently, and was caused by a thread timing issue which varied 
from system to system.  
 
If you are using Quantel MXF files as source files, there may be some issues, especially with older files. 
Please contact Digital Rapids Support for some custom settings that can aid in decoding these files. 
 
DRC-1000 to 2600 drivers: Fixed rare crash when input notification queue becomes full.  This was seen 
in the field once likely because of either a broken card or invalid input.  The driver kept thinking the status 
of the input had changed and the notification queue filled up.  The mechanism put in place to prevent 
overflow was not working properly and it caused a crash. 
 

Stream 2.5 Change History 
 

Stream 2.5 Highlights 
 
Included with LE/Pro/Enterprise:  
 
New video software plugin: deinterlacing 
 
The ability to insert copy protection data into MPEG2 files (CGMS-A and VChip)  (For those who have the 
MainConcept MPEG codec) 
 
Included with Pro/Enterprise: 
 
Thompson mp3 audio codec – included for new Stream 2.5 Pro/Enterprise customers. (This codec is 
available as an option for LE or for Stream 2.4 customers who are upgrading to 2.5.) 
 
New video software plugins:  gamma adjustment, 601/709 color space conversion 
 
Omneon MOV format writing (MPEG2 inside a QuickTime wrapper) 
 
QuickTime v.7 includes support for H.264/AMR/AAC (these codecs are not supported in LE) 
 
Support in Stream for the Rimage Server (as a DVD output option) – available for all Rimage/StreamPro 
customers, but a free key must be requested from Digital Rapids to expose the feature 
 
2.5.1: Support in Stream for the Primera Server (as a DVD output option) – available for all 
Primera/StreamPro customers . A free key must be requested from Digital Rapids to expose the feature 
 
2.5.1: Microsoft VC-1 elementary stream codec added – can be used to create Bluray files or can be 
used in the group codec to create muxed ASF files and streams. 
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New Options 
 
2.5.1: Digital Rapids Studio AVC codec – can be used to create Bluray files or can be used in the group 
codec along with additional options to create Transport Stream files for VOD or RTSP/RTMP live streams 
for delivery to a Media Server (e.g., Flash Media Server or Darwin Server).  
 
2.5.1:  Digital Rapids AVC for Flash 9: This codec includes The Digital Rapids AVC video codec, the Nero 
AAC audio codec, and the RTSP/RTMP protocol for live streams for delivery to a Flash Media Server. 
 
Codec for 3GPP support:  Dicas (video: H.263/MPEG 4 Part 2; audio: AMR and AAC) 
 
Optional Input File format: GFX reading 
 
Optional output format for Pro/Enterprise: MXF file writing 
 
2.5.2:  MPEG-4 Muxer processor for creating archive files now included when Digital Rapids Studio AVC 
or Ateme codecs have been enabled. 
 
2.5.2:  Digital Rapids AVC for Flash 9: Added File Writing using the new MPEG-4 Muxer; Added video 
only and audio only options; Added MP3 audio streaming option. 
 
2.5.2:  New tool to wrap encoded files in MXF; included if the MXF Writer processor has been enabled. 
 

Stream 2.5.1.b47 to 2.5.2.b63 
 
Added a new MPEG-4 Muxer processor for creating archive files.  
Available as a processor in the group codec when Digital Rapids Studio AVC or Ateme codecs have been 
enabled. Also available from the Digital Rapids AVC for Flash 9 codec. 
 
Added a new tool to wrap encoded files in MXF; included if the MXF Writer processor has been enabled. 
 
Added MP3 audio streaming using Native RTP processor (in the group codec) or from the Digital Rapids 
AVC for Flash 9 codec. 
 
Allow audio-only or video-only clip lists. After setting Clip List as your Input Type, choose ―none‖ in the 
video or audio drop down if your clip list does not include that type of media. 
 
Closed Captioning for MPEG2: Reversed the packet order of the Dual CC placement in MPEG2, so that 
the SCTE 20 user data packet is put before the ATSC A/53 user data packet.  This is required for VOD 
files made for a CableLabs server. 
 
Improved the exit process from Stream which kills all associated processes when you exit Stream. 
(Previously if the encoder locked up, some processes were not killed when you exited Stream.) 
 
Field Dominance Converter Plugin: Do not swap field 1 and 2 timecode and VBI data. 
 
Don't show Vista warnings when the OS is Windows Server 2003. 
 
Fixed a bug in the Group Codec: Plugins that were applied to a codec that were part of a Group Codec 
were deleted when an individual codec was modified. Note that this bug has not been fixed when using 
the DR AVC for Flash 9 codec (a special use case of the group codec structure). 
 
RTMP Streaming: 
Update to Adobe RTMP SDK 1.0.1 which includes bug fixes to increase the stability of the live stream. 
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Update support for RTMPT streaming, especially for reconnection issues. 
 
Native RTP Streaming: 
Fixed some SDP issues when using video only or audio only and sending to Darwin server. 
Fixed some SDP issue related to local sdp file when streaming to Darwin server or Built-in server. 
Some fixes to better support streaming to Akamai server through RTP. 
 
Adobe Flash 8 On2 Codec: 
Update to On2 SDK 2.4.5.0 
- metadata preservation in files, and some metadata preservation in live streams 
- Can once again make SWF files 
Includes a fix for transcoding to On2 from files that have some frames that have the same timestamp as 
the previous frame. 
Added feature to enable On2 VP6-S encoding type via a registry key setting (without this key the 
encoding type is VP6-E).  This will also add an entry to the Metadata to inform the user if the profile 
selected is "VP6-E" or "VP6-S". 
The registry key to enable is: 

Windows Registry Editor Version 5.00 
[HKEY_CURRENT_USER\Software\DRC\On2] 
"UseVP6SProfile"=dword:00000001 

 
QuickTime: 
Fixed a bug that caused QT capture to 23.978 fps to have a lipsync problem 
Fixed a bug that caused GUI crashes when entering QT dialog using AVID codec pack 1.8 or 1.9  
Fixed a problem when transcoding from QuickTime file source that occasionally causes the application to 
lock up at the end of the encoding. 
For QuickTime encoding, if the output frame rate is greater than the input frame rate the encode will fail 
with an error message that tells the user that going to a higher output frame rate is not supported. 
 
Omneon MOV files: 
Use a new a decoding method for decoding Omneon MOV files in Stream 
Always include timecode in output Omneon MOV. It will default to Zero TC if none is present. 
Allow user to delete Audio files from the Omneon dialog, even if these files were added automatically. 
Fix bug that caused, Aiff multichannel audio to show up as mono. 
Dicas: 
Bug fixes to allow Dicas encodes to Stream to Akamai server. 
Use the correct profile Level/Id when using MPEG4 encoder and bit rate is less than 64kb/s. 
AAC audio was incorrectly encoded at 96kbps when bitrate was lower than 16kbps. It will now correctly 
support down to 8kbps. 
 
File trimming behavior can be changed based on a registry setting. The two behaviors are ―true seek‖ and 
―play to in point‖. The ―true seek‖ behavior is the default behavior if the reg setting is not present. This 
was introduced as the ―true seek‖ method will not work if the file has seeking issues. 
 Windows Registry Editor Version 5.00 
 [HKEY_CURRENT_USER\Software\DRC\KMDSFileSource] 
 "EnableTrueSeeking"=dword:00000001 

(Disable: set the dword to 00000000) 
 
Chinese translations of most of the Stream gui will be enabled if a Chinese OS is detected.  
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Stream 2.5.0.32 to 2.5.1.b47 
 
Warning 
 
This build includes an updated On2 SDK that does not support SWF file creation. If you require SWF file 
creation you will need to apply a patch to the Stream 2.5.1 build or to update to Stream 2.5.2. 
 
Codec changes 
 
Microsoft VC-1 elementary stream codec added – can be used to create Bluray files or can be used in the 
group codec to create muxed ASF files and streams. This codec requires StreamPro or Enterprise. 
 
Digital Rapids Studio AVC codec – Can be used to create Bluray files or can be used in the group codec 
along with additional options to create Transport Stream files for VOD or RTSP/RTMP live streams for 
delivery to a Media Server (e.g., Flash Media Server or Darwin Server). This codec requires StreamPro or 
Enterprise. 
 
Digital Rapids AVC for Flash 9: This codec provides an integrated interface for Flash 9 live streaming. It  
includes the Digital Rapids AVC video codec, the Nero AAC audio codec, and the RTSP/RTMP protocol 
for live streams for delivery to a Flash Media Server. 
 
QuickTime: 
- Fixed a few memory leaks, including the one that caused a large memory leak when Uncompressed 
video, Preserve TC and PCM Audio are selected.  
- Fixed a bug so that QuickTime audio only encoding works 
- Fixed a bug that caused QuickTime to encode at a frame rate that is little bit off from the selected one 
(due to a rounding error).   
- Fixed a bug that caused QuickTime audio and video durations to be different. 
 
MainConcept MPEG2: 
- MainConcept decoder deinterlacing is now directly controlled by Stream encoder.exe. Previously the 
decoder was deinterlacing the video by default. 
- Updated MainConcept MPEG2 SDK. 
- Added Cable Labs constant for MainConcept profile. 
 
On2 Codec (Flash 8):  This build includes an upgrade to On2 SDK version 2.4.2.0.  This updated SDK 
includes the following: 
- metadata preservation in files (but not in live streams) 
- mono audio is fixed in older players 
- However, you can’t use this version of the SDK to make SWF files (see warning above) 
Additional On2 codec changes: 
- Fix for auto-aspect ratio adjustments and the On2 codec. This fixes a bug where any time the video 
dimensions needed to be changed by Stream for an On2 codec profile it would result in an unusable 
codec profile. 
- Fix for a bug involving Limelight publishing after a reconnection.  Before the fix Limelight broadcast 
streams were not published correctly due to an improper publish call.  With the fix a more robust 
mechanism have been put into place to publish the stream properly upon a reconnection. 
 
General Changes and Bug Fixes 
 
Added support for Primera DVD Burner Server. Requires a registry setting to enable. 
 
Fix DTD URL in Rimage order XML.  Fixed DVD UDF Format - now 102ISO instead of 150_Unicode (to 
fix UDF Format issue with Rimage DVD Burner Server). 
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Integrated the StreamScheduler into the main installer as an optional feature. Previously this feature had 
its own installer, but that was causing version incompatibility problems. 
 
Deck Control:  
- Allow the user to disable the warning about overwriting files if system tags are not used 
- Fixed a deck logger problem. When a new tape is inserted, a dialog shows up to allow the user to select 
the tape. If a new tape name is added, the new tape name was not automatically selected. 
- Deck Capture warning: Fixed a bug where warning for SCC + Deck Capture validation wasn't being 
triggered when SCC was completely out of range of the deck clip in/out points from the top end.   
 
Corrected the error message that is displayed when the license limit is exceeded. 
 
Fixed group encoder to report the maximum frame size in the status bar. 
 
Added %APP.HARDWARE.NAME% tag. 
 
Fixed a memory leak in the software cropping plugin. 
 
MXF File Writing/Reading: 
- MXF Reading now can handle 16 track audio (previously it could only handle up to 8 tracks) 
- Fixed a bug that could cause problems when reading MXF files with multiple audio streams.   
- MXF writing: changed default stream buffer sizes to 16384; exposed SDK stream buffer sizes in UI 
- added ability to wrap WAV streams as AES3 in OP1A and OPAtom output patterns. 
- Fix: Invalid MXF file hangs Stream during preview/encode. Solution: Stop method now explicitly stops all 
media sources, so that the Stream will respond when the Stop button is pressed. 
 
GXF Import bug fix: GXF file with DV video is now decoding properly  
 
Improvements to the DRC-5650 DirectShow Preview Player App and SDK. 
 
DRC-5650 and 5550 drivers: 
- Fixed a cropping lock-up that would occasionally happen when no SDI input was present. 
 

Stream 2.4.1.67 to 2.5.0.32 
 
Codec changes 
 
Added Dicas codec support. This new optional codec support H.264/AVC, MPEG4 Part 2, H.263, AAC 
audio, AMR audio. It supports both file creation and live streaming (native RTP broadcast). 
 
Added GXF Import support: This new option allows you to use GXF files as a Media File type (read GXF 
files so that you can transcode them to other formats). Note: GXF unwrapping is supported.  Additional 
codecs may be required to read the elementary video and audio streams inside the GXF wrapper. 
 
Added MXF file writing support (wrapping): This new option allows you to choose the MXF wrapper as a 
new Processor in the Group Codec. Note: MXF wrapping is supported, but additional codecs may be 
required to write the elementary video and audio streams inside the MXF wrapper.  
 
Added the Thompson mp3 audio codec – This codec is included for new Stream 2.5 Pro/Enterprise 
customers. This codec is available as an option for LE or for Stream 2.4 customers who are upgrading to 
Stream 2.5. 
 
Omneon MOV format file writing is included for StreamPro/Enterprise customers (MPEG2 plus audio 
inside a QuickTime wrapper). This feature is available as both a post encode output option that 



 Digital Rapids Stream 3.1 Software 

Digital Rapids Stream 3.1 Software September 9, 2009 16 of 21 Page 16 of 21 

automatically wraps the MPEG2 and audio files that have just been encoded, as well as a tool that can be 
used to wrap previously encoded MPEG2 and audio files. 
 
Updated the MainConcept MPEG codec to version 7.5.  This new version includes improvements to the 
D10 quality, quad-byte alignment for CableLabs compliance, an improved decoder, as well as various 
other fixes.  Additional MainConcept changes: 
- The decoder now decodes video without deinterlacing it by default 
- When ―no fields‖ is selected the progressive sequence flag is set to 1 automatically 
- The default quality has been increased to 30 (maximum is 50) as most CPUs can now provide the 
processing power needed to handle this higher default quality 
- Added a new option for XDS data insertion, which includes options for CGMS-A data and Content 
Advisory (V-Chip) Information 
- Added new closed captioning options so that users can choose which type of captions to add to the file:  
ATSC A/63, ATSC A/53, SCTE20, Dual ATSC A/53 + SCTE20 
 
Adobe Flash 8 On2 updates: 
Updated to the On2 VP6 SDK to version 2.2.15.0.  This version of the SDK fixes the transcoding bug 
where frames were cut off at the end of a transcoded file.  It also fixes the long-term live streaming issue 
where the audio and video timing would gradually drift apart until the encoder failed (at approximately 14 
hours).  Additional changes: 
- Added an On2 reconnection feature for live streaming. This feature will detect if a broadcast stream has 
disconnected and attempt to reconnect the stream at 15 second intervals. A disconnected stream will 
attempt to reconnect for 5 attempts.  If a stream is unable to reconnect after 5 attempts the encode 
session will fail. 
- Updated the codec to use the Thomson MP3 audio codec (The LAME audio codec was used in previous 
releases.) 
- Updated the Akamai and Limelight login procedures to provide more graceful connection to the servers. 
- Enabled the alpha Option in On2, which allows Stream to pass RGB32 video to the encoder for 
transcoding. 
- Reorganized parts of the On2 codec profile gui to make the functionality clearer 
- Enabled SWF dimensions feature in On2 codec profile gui 
 
QuickTime codec changes: 
Updated the QuickTime  SDK to version 7.1.  When using existing QuickTime codec profiles from earlier 
builds of Stream you will see an error message warning you to update the audio profile, as the method for 
handling audio is not backwards compatible.  Other changes: 
- Multi-channel audio is supported (mono to 8 channels) 
- StreamPro and Enterprise:  the Apple H.264 video codec is supported, as well as AAC LC and AMR NB 
audio codecs. Note that for Stream LE customers these codecs are not supported. If you have a Stream 
LE license and you choose one of these codecs, when you start to encode you will be warned that you 
are not authorized to use these codecs. 
 
Digital Rapids AVC (Nero Digital) codec changes: 
- Added a new option to modify files to allow progressive download for a Nero Digital AVC/H.264 file 
(involves moving the MOOV atom in the file from the end of the file to the beginning of the file). This is an 
option in the Archive output dialog when writing an AVC/H.264 file, and it is enabled by default. 
- Added two more file extensions to the Nero Digital window list (f4v, flv) for Flash 9 file compatibility 
- You can now transcode to the Nero Digital codec from source files with 24-bit audio. The 24-bit audio 
source will now automatically get down sampled to 16-bit (as required by the Nero Digital codec). 
- Fixes for the 2-pass encoding option to allow better specification of the temporary first pass bin file. 
These changes allow it to work properly when called from Digital Rapids Transcode Manager. 
 
Closed Caption codecs: 
- SCC: Fix for a bug in the SCC encoder where the caption timecode would drift away from the actual 
timecode from the video.  The bug was caused by an imprecision in the calculation of the timecode from 
the frames when dealing with 29.97 fps frame rates. 
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- In SAMI output files the reference to "&nbsp" should actually be "&nbsp;" with a semi-colon 
 
Windows Media codec: 
- Fixed a problem in Windows Media encoder when determining which deinterlacing mode to use in MBR. 
- The Windows Media Codec Distributable wmfdist11.exe included in the installer is now Version 6.1.22.4. 
This version works better with Server 2003. 
 
MXF authorization:  Fixed an MXF authorization issue that primarily affected it’s use with Digital Rapids  
Transcode Manager 
 
Image Sequence: Added start time and end time to image sequence encoder output. 
 
DRC Video File format changes: 
- The DRC Video format has been changed slightly to include ancillary data. DRC Video files encoded 
with earlier versions of the software will need to be converted before they will be able to be decoded. A 
DRC Video file converter is available for this conversion task. 
- The DRC Video Properties page (displayed when you right click on a DRC Video file and choose 
Properties) has been enhanced. 
 
Fixed a Sorenson ACE profile reading problem. 
Fixed a Sorenson ACE profile name problem. 
Fixed a Sorenson ACE SWF encoding problem. 
 
Deck Capture bugs/changes 
 
Deck control behavior has changed slightly. Now when a new tape is inserted a cue command is always 
sent by default. This resolves an issue where the timecode type was not correctly detected after a tape 
change unless the tape was played for a few seconds. 
 
When ―concatenate clips‖ is enabled, capture the clips in the order that they have been entered (that is, 
do not sort them by timecode before capturing them).  Note that when ―concatenate clips‖ is not enabled 
Stream does sort the order in which it records clips. 
 
The Logger’s 24-hr and 12-hr timecode wrapping options are once again working as expected. For 
example, with 24-hr wrapping enabled, with an in point of 23:59:30:00 and an outpoint of 00:00:30:00 the  
duration is correctly shown as 00:01:00:00, and the capture starts as expected. 
 
Stream will ignore the video input signal from the deck during stop or shuttle modes, and will only attempt 
to detect the video input when encoding is about to start. This will help to prevent ―failed to detect SDI 
video input‖ errors when using certain decks along with an SDI input and Deck capture to encode a list of 
clips. 
 
Fixed: Deck Capture: No preview was shown after first clip in the capture list was encoded (you had to 
toggle the preview button to see the preview for subsequent clips). 
 
Fixed: Deck capture to MPEG2 when encoding closed captions from SCC file source failed. 
 
When a project is open that has an existing deck capture log, if Stream detects that the frame rate of the 
SDI input does not match that of the capture log, a warning will be displayed that tells the user that they 
must clear the capture log to re-set the frame rate used by the capture log. 
 
General Changes and Bug Fixes 
 
New video software plugins:   
For Stream LE/Pro/Enterprise customers: software deinterlace plugin 
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For Pro/Enterprise customers:  gamma adjustment, 601/709 color space conversion, Field Dominance 
Converter 
 
When the codec profile is modified, the plugin settings are no longer lost. 
 
Support in Stream for the Rimage server (as a DVD output option) – This feature is available for all 
Rimage/StreamPro customers, but a free key must be requested from Digital Rapids to expose the 
feature. Currently Rimage 8.0 is supported. 
 
Native RTP Processor in the Group Codec: Added support for unicast to a Darwin Server, including SDP 
file announcement and username/password announcement. 
 
System Tag: Added %N.#% as short form of %FILENAME.NUMBER.#% 
 
Add tooltip to Output’s Archive window listing common tags used for file names. 
 
Added a subject field to the Email Output option to allow the user to define the subject of the email. 
 
When trancoding files and also using the Graphics Overlay plugin, only media source files that used 
YUY2 or UYVY were being transcoded. When using a media source file that used RGB the graphic 
overlay plugin would fail. Now when transcoding media source files that are RGB, the graphic overlay 
plugin will work correctly. 
 
Added Silverlight sample template files to the installer (installed by default in C:\Program Files\Digital 
Rapids\Stream\PublishTemplates\Silverlight_Sample) 
 
Added WAV codec as an option to the group codec; primarily used to create certain MXF file types. 
 
Added WAV RF64 support for WAV files over 2 GB in size. 
 
Add a warning message to alert the user if they have hardware de-interlace enabled and have also 
applied the IVTC filter. 
 
When an illegal character (such as an &) is used in a file name or folder name Stream now returns the 
correct error. 
 
When using a Watch Folder with concatenate enabled, the status indicator is now updated from a red dot 
to a green check (to indicate successful completion). 
 
When using a Watch Folder, files encoded with some codecs were being picked up by the watch folder 
process before the file had finished encoding. Problematic codecs were Flash, MPEG, Real, QuickTime 
and Wav.  This has now been resolved. 
 
Fixed:  When using the trimming options for Media File input, the settings entered are stored, and when 
you go to File > New Project the trimming parameters were not being cleared when starting the new 
project. 
 
When using the group codec, the correct error message will now be generated when an illegal character 
is used for the output file name. 
 
When using the group codec, if the H.264 or MPEG2 codec uses an SCC file that cannot be found, then 
an appropriate error message will be displayed (previously this could lock up the app). 
 
DRC Hardware Drivers – changes and bug fixes 
 
DRC-5560 and 5550 boards: 
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- Fixed the random number generator used for random dithering. 
- Fixed bugs related to playback engine rendering interlaced video in frame mode. 
 
DRC-1000 to 2600 boards: 
- Changed the field 2 VBI minimum start line from 273 to 272 and fixed a field 2 VBI line problem 
- Changed audio timestamp calculation to use floating point.  The old way (using fixed point) would cause 
an overflow of the numerator after about 14 months. 
- Changes that help to avoid timing problems when 2 streams are capturing, starting, and stopping 
simultaneously. 
- Changes that fix the "31 dropped frames" problem that can occur without the host buffer filling up. 
   
Note: No changes for the DRC-500 board. 
 
DRC Key Change 
 
This release uses the new key authorization structure, expanded to allow more codecs/options. All keys 
made after April 13, 2008 will use this new key structure. If you are using a new key and Stream 2.4 or 
earlier, use the DRC Key Patch found on http://www.digital-rapids.com/Support/StreamSupport.aspx.  
 
 

Known Limitations 
 

Vista Issues 
 
Disable the Vista power saving mode. When Vista enters ―power saving mode‖ (hibernation), the DRC 
Stream hardware is disabled, and when you return to the normal mode and attempt to use the DRC 
Stream hardware again, it cannot be re-enabled without rebooting the system. 
 
Turn off the Vista UAC (user account control) before installing the Stream software (including drivers for 
the DRC Stream hardware).  Keep the UAC off when using the Stream software.  
 
After encoding an archive file, when you click on the Play button next to the Archive button to open the file, 
if the file would normally be played back in Windows Media Player the player will open, but the file will not 
be loaded.  This same player behavior can be seen outside of Stream in Windows Explorer by right-
clicking on a media file and selecting ―Open with‖ and selecting the Windows Media Player: namely the 
player will open, but the file will not be loaded. 
 
The Stream Scheduler does not work on Vista. The current work around is to add tasks to the Windows 
Vista Scheduled Tasks manually. Please contact Digital Rapids Support if you need help setting this up. 
 
The ASF Processor does not work in Vista. This is the processor used in the group codec to create ASF 
files using the Microsoft VC-1 video elementary stream codec. As a work-around, you can use the 
Microsoft Windows Media codec to create wmv files that contain VC-1 until this issue is resolved. 
 

General Issues 
 
- DRC Studio AVC: When encoding using MBAFF mode ONLY you will see a significant performance 
decrease. You will still be able to encode an SD input in real time using MBAFF. However, if you are 
encoding multiple profiles simultaneously, real time performance may be affected. Transcoding speeds 
will be approximately 50% of the speeds in Stream version 3.0. This does not affect 720p or 1080p or 
1080i encoding, just MBAFF. This will be addressed in a Stream 3 maintenance release.   
 

http://www.digital-rapids.com/Support/StreamSupport.aspx
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- When the Timecode Overlay plugin is used, rendering the timecode will take some system resources, 
and the larger the font the more CPU usage will be required. When using this plugin during a real-time 
capture, if dropped frames are reported, reduce the font size. 
 
- The BluRay AVC 720p and 1080p sample codec profiles make files that are not working in Sonic’s DVD 
authoring tools. However, those same files work when using Roxio Bluray authoring tools, and the Bluray 
dics play back correctly.  (The 1080i29 project make files that can be used with Sonic’s DVD authoring 
tools.) 
 
- KMMXFWrapper.exe can be used to wrap Avid DNxHD files as MXF, but it is very slow. 
 
- ASF live broadcast stutters when Closed Captioning Scripting is enabled for some footage (in particular, 
footage with long caption breaks).  This does not occur if an ASF file is created with Closed Caption 
Scripting - the file plays back without stuttering. 
 
-  Digital Rapids does not support 64-bit Windows OS on any of the currently shipping boards. 
 
- You cannot capture analog video along with embedded SDI audio.  (Issue only applies to DRC-1400 to 
DRC-2600 boards.) 
 
-  The "Fix Aspect Ratio" feature does not work for some Codec Profiles. 
 
-  DVD chapter marks may be one or two frames off from the clip in-point. 
 
-  Stream is unable to transcode from YUV image sequence files. 
 
-  When using the DRC-5550/5650 board, you can only capture timecode from RS422 when using deck 
control. 
 
-  When using the DRC-5500/5650 board (the HD board), if you are making a DVD Output with 
concatenate and you are using format conversion, then the audio video sync will drift.  (If you are not 
using format conversion the audio and video will remain in sync.) 
 
-  When using rollover mode (for archive files) and incrementing number is added automatically, but tags 
are only generated for the initial file (e.g., if %D_% is used, only the date of the initial file will be used for 
all files). 
 
-  When using rollover mode the clip that was just closed will be missing the last couple of seconds of 
audio and there may be a slight video freeze at the beginning of the next clip (a couple of seconds).  The 
audio continues normally in the new clip.  When the video starts moving again in the new clip, the video 
and audio are in sync.  
 
-  When using the roll over mode for both a Windows Media codec and a SAMI codec, the SAMI file will 
be a little out of sync with each successive roll over clip.  This is a known issue for roll over mode. 
 
-  When using rollover mode with Real Helix, the clips must be at least 60 seconds long. 
 
- Stream software cannot decode AAC audio only files. 
 
- If you have a DRC-1400 to 2600 board, and you enable the VBI before you have a video source input 
connected, you will see a green mask over the VBI while monitoring.  Once you connect a video source 
input it will take a few seconds for the green mask to go away. 
 
- When using the Inverse Telecine plugin, if you need to encode to an AVI file, do not set the Source Type 
to Unknown.  Set it to Film or Video.  When set to Unknown the video and audio loose sync.  Note that 
this does not happen when encoding to other codecs, just when encoding to AVI. 
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- For MPEG-4 File muxing, if you use MP3 audio, only Stereo audio is supported. Mono audio is not 
supported. Playback will work in the QuickTime player, but not in the VLC Player. Other players results 
may vary with regards to MP3 playback. 
 
- When adding Chapters to an MPEG4 File, a Chapter will be automatically added at time 00:00:00:00. 
For some players this Chapter must have a name (it cannot be an untitled chapter). 
 
- Live Streaming using RTP/RTSP or RTMP with Nero AAC audio will fail after approximately 180 hours 
(7.5 days). 
 
- When creating Avid DNxHD files wrapped in MXF, you must specify the audio codecs in the inverse 
order in the group codec, in the right side panel, in order to create the files with the correct track order 
when imported into Avid Media Composer. 
 
- When creating Avid DNxHD files wrapped in MXF, the wrapping process will not be able to happen in 
real time. You must encode the video and audio elementary streams first, then use a post-encode 
command to wrap the files in Avid OP Atom. 
 
- If you attempt to decode DVCPro 50 or HD and you have not purchased the DVCPro decoder for 
Stream, the file will not be rejected by Stream, however it will not decode correctly until you purchase the 
decoder. This also applies to MXF, GXF, LXF or MOV files that contain DVCPro. 
 
- When using the DRC-5650 Preview DirectShow app, the first time an ASF/WMV file is played the video 
scrubbing will not work. If the same file is opened a second time, the video scrubbing will work. Other file 
types do not have this limitation. 
 
- Manzanita muxer: Adaptation Properties for PID 0x01E1, NoEmptyAF=YES: The Manzanita muxer was 
updated in Stream 3.0, and the pre-installed CableLabs projects were modified so that the PAT and PMT 
insertion frequency (under TRANSPORT—PSI settings) now needs to be set to 8. This is required in 
order for NoEmptyAF=YES. If you are using an older project created in 2.5.0 with newer versions of 
Stream, then you must update those values. 
 
- When previewing a project that includes a group codec with multiple audio codecs, before encoding all 
audio codecs will be used for the preview. However, during the encode only the first audio codec will be 
used for the preview. All audio channels will be encoded in the file.  
 
- Digital Rapids AVC – Nero Digital encoding limitations: 

- For Mobile AVC ALL profiles default to 15fps no matter what frame rate is set in the profile. 
- For Memory Stick AVC ALL profile default to 30fps no matter what frame rate is set in the profile. 
- Nero Digital Video Decoder decodes 1920x1080 files to 1920x1088, and decoded 160x120 files 
to 160x128.  The following frame sizes are decoded correctly: 1280x720, 720x480, 640x480, and 
320x240. 
- When transcoding a stereo file source to mono AAC(LC or HE) Audio, the resulting file has 2 
channels of Audio. That is, you cannot create a mono file. 

 
- Sorenson ACE codec:  At resolutions 640x480 and 720x480 you can use frame rate setting -1 (original 
frame rate) but not -2 (half the original frame rate). 
 
- Sorenson ACE codec does not work on the Vista OS. 
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